




























































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































Chapter 30 Integrating the Applications 

The Mac System's own Publish and Subscribe, in contrast, has proved itself exceptionally 
robust. Probably because it's been around for a few years and is thus more or less bug-free and 
because Microsoft's own programming efforts don't appear to conflict with it, Publishing from 
one application and Subscribing in another is a reliable way to exchange data. It is better than 
using the Paste Link command and far better than object embedding, at least in the current 
state of Word 6 and its friends. 

Special data exchange: Present It and Report It 
One built-in Microsoft technique, however, works very nicely. Word 6 has a special Presentit 
macro that sends documents into PowerPoint, and PowerPoint returns the favor with a button 
called Report It. I' ll give you details on this slick arrangement at the end of this chapter. 

Excel Data into Word 
The first t ip you need is this: get Word 6.0.1, the early 1995 update. The simple reason for this 
recommendation is that the first version of Word 6 is prone to crash when you try to establish 
Excel links! 

Then you have a decision to make before you send data from Excel into Word: 

+ Will the Excel data be changing frequently? If so, it's worth the effort (and perfor­
mance hit) that results from live data links between documents. 

+ Is t he Word document supposed to be a "snapshot" of conditions at a particular 
time? In this case, you will just be creating confusion unless you do a one-time, 
one-way data transfer. 

Pasting 
Using the Cut, Copy, and Paste commands is still the easiest way to transfer modest amounts 
of data between applications. First make sure that both Excel and Word are open. You can use 
Office Manager-the little icon to the left of the Help button on the Finder menu-to open the 
applications. Then in an Excel worksheet, you can select the table of information that you 
want (see Figure 30.1) and choose the Copy command from the Edit menu. 

Now switch to Word, open the document in which you want to insert the Excel table, and put 
your cursor in the proper place for the table. Choose the Paste Special command from the Edit 
menu. The Paste Special dialog box appears (see Figure 30.2). In this dialog box, you can 
choose to paste the Excel data into the Word document as regular text, paste the data as 
formatted text (RTF), or choose the Paste Link option to make a Jive link, whether you retain 
the formatting or not. 
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Figure 30.1 A little Excel table for export. 
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Figure 30.2 The many kinds of Paste. 

An RTF paste link gives you the table shown in Figure 30.3 in your Word document. When 
you choose the Paste Link option rather than the Paste option, the data in the Word docu­
ment changes when you change the original data in the Excel worksheet (the update occurs 
every time you open or save the Word document). 
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Figure 30.3 The Excel table in Word. 

If you do lo ts of reporting, here's a t ip that can save you plen ty of grief. W hen you make a 
table in Excel that you propose to use in Word, use the Insert Date command to put an act ive 
date somewhere in the table. In th is way, by just looking at the table in the Excel document, 
you can determine which version number of the table you are using because the last update is 
clearly indicated by the date. 

Publishing 
The Paste Lin k option works t h rough Microsoft's own object li nking and embedding (OLE) 
scheme. Th is way of transferring information duplicates the services that Apple already built 
into the Macintosh system long ago in its Publish and Subscribe features. 

In principle, the Paste Link option and the Publish and Subscribe feature should work in 
almost the same way to exchange data. In practice, however, using Publish and Subscribe is 
significa ntly more stable than using ei ther linking or embedding. Furthermore, because the 
rest of your Macintosh applications a lso use the Publish and Subscribe method of transferring 
information between applications, using th is method in Office doesn ' t require any training or 
re-orien tat ion. In the first few editions of Office, using OLE2 links between documents was 
fa irly troublesome, while using the Publish and Subscribe links caused no problems at all. 
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Microsoft, if history is any guide, can be counted on to fix its Mac OLE2 glitches, but without 
any sense of urgency. 

To transfer information by using Publish and Subscribe, follow th ese steps: 

1. Select an area in your Excel spreadsheet that you want to paste into a Word 
document. 

2. Choose Create Publisher from the Publish options on the Edit menu. A dialog box 
similar to the one shown in Figure 30.4 appears. Give the selection its own name in 
the Name of New Edition text box. This action creates a file within a file and 
defines your selection as a "publishable" edition of data. Click the Publish button. 

Preulew lo Microsoft EHcel s •I = Mm:lntosh HO 

~~4sheet -()- [ Ej ect ) 
j1owu ~ 

( Desk top ) ~ otutt [dillon # 1 1 

IAll!!!- lobl 

11 
i! llemo/ ttl -ppt ( New CJ ) . .,. li Dlolog Edit or ..... ~ 

.u-~~t ... 
Name of new edition: ( Cancel ) 

IHii IIIJH'f'W I I Publish l) 
( Options ) 

Figure 30.4 Publish, a nice safe choice. 

3. Switch to Word, open the document, and place the cursor in the place that you 
want the Excel table to go. From the Edit menu, choose Subscribe. The dialog box 
similar to the one shown in Figure 30.5 appears. Highlight the name of the new file 
that you've created and click the Subscribe button. The text is automatically 
inserted into the Word file. (If you never have done Publish and Subscribe before, 
you may want to review this technique in the Apple Guide.) 

When you make the connection between your Word and Excel documents in this way, the 
files are mutually updated every time they open, close, or save. In this type of linkage, you 
shouldn't try to edit the table that appears in Word because Excel has been defined as the 
data source. If you want to have editable Excel data in Word, simply perform a simple Paste 
function (not Paste Link). 
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Figure 30.5 Subscribing in Word. 
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Excel and PowerPoint 
Because PowerPoint was originally designed as a stand-alone application, it has its own 
facilities for maintaining tables of data and creating charts. But the business reality is that 
most companies in the Office milieu use Excel as the main collection point for data because 
Excel has such well-defined links to externa l databases. So you probably have your data in 
Excel along with various lovingly hand-crafted and fine-tuned charts, as well. 

But Excel charts are dull, while PowerPoint charts provide a nice set of attractive stock back­
grounds and shadings so that your presentations look professional. It doesn 't make sense to 
redo all this work in PowerPoint, so you need to transfer your Excel charts to PowerPoint by 
following these steps: 

1. In your Excel worksheet, double-click the chart that you want to import into 
PowerPoint (see Figure 30.6). You need to see the gray cross-hatched border around 
the chart to know that you have activated it. 

2. Open PowerPoint (if you haven't already), choose Blank Presentation, and double­
click one of the Auto Layouts in the New Slide dialog box that has room for a chart. 
A screen like the one in Figure 30.7 appears. 

3. Go back to Excel and choose Copy from the Edit menu, which copies the selected 
chart to the Clipboard. Now switch to PowerPoint and choose Paste Special from 
the Ed it menu. The Paste Special dialog box appears. The dialog box has, in fact, 
anticipated the Excel chart import as a likely action (see Figure 30.8). 
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Figure 30.6 An Excel chart for export. 
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Figure 30.7 Finding a Power Point home for your Excel chart. 
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Figure 30.8 Power Point knows that you want to use Excel charts. 

4. After clicking the OK button in the Paste Special dialog box, your chart is pasted 
into the PowerPoint slide as a resizable ob ject (see Figure 30.9). You can also 
modify chart properties, if necessary, by using the Formatting toolbar, and you can 
add text and a title to the slide . 
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Figure 30.9 The Excel chart pasted into a PowerPoint slide. 
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WordArt in PowerPoint 
There are several ways to use Word in connection with PowerPoint. PowerPoint can accept 
Word text when you use the Paste command or when you use the Paste Link command, which 
updates itself. If you have already written a Word report on some topic, you can cannibalize 
most of it to make a snappy presentation in PowerPoint. You may also have developed some 
zingy special effects (company logos, spedal headings, or titles) for your Word documents 
by using WordArt. Rather than create these effects again, you can place them directly 
in PowerPoint. 

Simply follow these steps to transfer a WordArt graphic from Word to PowerPoint: 

1. Open the word document that contains the WordArt graphic you want to use. 

2. The WordArt appears in your Word document surrounded by the little sizing 
handles that accompany graphics (see Figure 30.10) . Select it with a single click 
and choose the Copy command from the Edit menu. 

Figure 30.10 WordArt as a sizable object in a Word document. 
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3. Switch to PowerPoint and paste the WordArt graphic where you want it to go in a 
PowerPoint slide (see Figure 30. 11). If you use the Paste Link command, changes 
will be updated in PowerPoint when you make them back in the Word doc­
ument. However, Word 6 still seems to have some problems with the Paste Link 
command, so using the plain Paste command is probably much safer from a crash­
proofing standpoint. 

So far this section has concentrated on importing WordArt to PowerPoint from a Word 
document because it's very likely that you have done most of your WordArt experimentation 
in Word. By this time, you may already have a repertoire of flashy or interesting WordArt 
graphics in your Word documents. 

But what if you have never used WordArt, and you want to insert a graphic into a PowerPoint 
slide? In this situation, put your cursor at the position in the slide where you want the graphic 
to go. Then choose the Object command from the Insert menu. From the Object Type list in 
the Create New tab, select a WordArt option, and in the dialog box that appears, create your 
own WordArt from scratch (see Figure 30.12) . WordArt, like Microsoft Graph and Equation 
Editor, is actually an independent stand-alone "helper" application that can be call ed up from 
any application in Office. 

Figure 30.1.1 WordArt in a PowerPoint slide . 
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Figure 30.12 Create your own WordArt in this dialog box. 

Word Outlines in PowerPoint 
PowerPoint can also accept Word outlines. At the simplest level, you simply copy an outline 
document from Word and paste it into a blank PowerPoint slide. You can also expand the 
individual points of the outline and make them into individual slides with the Cut and Paste 
commands. There's a lot to be said for this ready-made approach to outlines from the stand­
point of logical clarity, as opposed to picking a template from the prepared choices in 
PowerPoint and then making up the slides from scratch. 

But Microsoft has installed a special pipeline between Word and PowerPoint, one that 
preserves outline structure. There are a few variations on this trick, but they all involve 
the Presentlt macro on the Word end of the pipeline and the Report It button on the 
PowerPoint end. 

To make this technique work, by the way, you need to have installed the complete version of 
Word 6 and the complete version of PowerPoint 4. The macros that make this outline transfer 
possible are obscurely located in the Wizards folders, so if you do a minimum installation of 
eitl1er application, you won't get th is feature. By the way, not only is this installation informa­
tion not explained in any detail in the Microsoft documentation, but information about this 
kind of file transfer between applications is amazingly skimpy everywhere. Present It doesn't 
even appear as an item in the index of the Word manual. 

First, make an outline in Word 6 by typing some headings in Outline view (see Figure 30.13) 
and using the arrow buttons to arrange the text by outline level. 
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Figure 30.13 A simple Word outline for export. 

Integrating the Applications 

Now there are two choices. In the first one, you go into the Finder and double-click the 
Present It icon to open a Present It window. You then cut and paste the outline into this 
window (see Figure 30.14) and save the file. When you switch to PowerPoint, choose the Open 
command from the File menu. In the Open dialog box, one of the options now available is 
to import an outline saved in this way. You just open the file, and the outline structure 
is preserved. 

The second choice is to activate the Presentlt macro from the Macro command in the Tools 
menu (see Figure 30.15). When you run this macro with an outline document open (actually, 
you can do it with any sort of Word document), the macro performs the file format conver­
sion, switches to the PowerPoint application, and opens the new outline file in PowerPoint in 
an untitled window (see Figure 30.16). 

What if you have developed an outline in PowerPoint that you would like to transfer to a 
Word document for further elaboration (see Figure 30.17)? An outline in PowerPoint (remem­
ber that PowerPoint has an Outline view just like Word) can be exported to Word with a mere 
click of the Report It button, the button to the left of the Zoom Control on the Standard 
toolbar. A single click on this button fires up a PowerPoint macro that delivers the outline into 
Word (see Figure 30.18). If you switch to Word's Outline view, you see that the level structure 
of the outline has made the journey intact. 
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Figure 30.14 Present It as a transporter to Power Point. 
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Figure 30.16 ... this window opens in Power Point. 
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Figure 30.17 An outline in a PowerPoint slide. 
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Figure 30.18 The PowerPoint outline arrives in Word. 

The nice thing about Microsoft Office is that you have to make elaborate creations, such as 
tables, outlines, and graphics, on ly once in the originating document. Because the Office 
applications are linked together in different ways, you then can import these creations into 
Word, Excel, or PowerPoint with just a few steps-a much easier technique than generating 
your creation from scratch all over again. Take the time to experiment with these links in the 
Office suite. The time you invest in learning how to transfer these creations will be t ime saved 
over and over again in the future. 
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Speed, the subject of Part VI, is exactly 
what Office doesn 't have. The simplest 
way to understand the often poky 
behavior of Office applications is by 
thinking about the Macintosh interface 
itself. Every time you click the mouse 
somewhere onscreen, the application that 
is running at the time has to look through 
its list of possible actions. If the list of 
actions (corresponding to the number of 
features) is gigantic, this is going to take 
lots of time. And the Office applications 
are the very definition of gigantic. 

So Part VI offers some tips for getting 
some speed back into operating the 
applications in Office. There are more 
Word tips than other kinds because Word 
is the worst offender-Excel is not much 
slower than its earlier versions, and 
PowerPoint 4 is actually fas ter than 
PowerPoint 3. Besides, there's nothing 
more annoying than waiting and wa iting 
for Word to load when you just want to 
type a four- line memo. Surviving Office 
largely means getting Word to perform 
adequately, so you should implement 
every bit of this hard-won advice. 
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Word 6 Speed Tips 

Get the upg rade! 

If you are still using the United States version of Word 6.0, update to Word 6.0.1, the 
fastest version of Word for the Mac. You can get it at no cost by calli ng (800) 315-5081. If 
you don't have the United States version of Word (and you almost certainly don't if you 
bought Word outside of the United States), consult the introduction to the Word User's 
Guide to find the phone number of your Microsoft subsidiary and call the subsidiary. 

If you run Word on a Power Macintosh, use the PowerPC-compatible version of Word. 
To get the Power PC version of Word, call Microsoft at (800) 426-9400 or (206) 936-8661. 

To find out more about your copy of Word, with Word launched, choose About Microsoft 
Word from the Apple menu. Look at the top of the About Microsoft Word dialog box to 
discover your Word version number. If you are running the Power PC version of Word, the 
dialog box describes it as being for Power Macintosh. 

When a new upgrade of Word comes out, contact Microsoft to find out what speed and 
performance boosts you can expect from the newer version, and don't buy anything if you 
don't think it will be worthwhile. 

Eliminate exten sions 

Turning off your extensions is the standard remedy for any Macintosh problem. It is 
particularly recommended by Microsoft tech support people because they know that Word 
has a long list of incompatibilities with popular Mac extensions. 

To see if you have a problem with extensions, shut off your Mac and then restart it while 
holding down the Shift key. You see an Exte ns i ons Off notice while your Mac reboots. 
After the Mac restarts, launch Word and see if it runs faster. If turning off the extensio ns 
didn't help speed up Word, don't worry about it. just restart your Mac again and things 
will be back to normal. 

If, on the other hand, turning off extensions did help get you more speed, you have to 
figure out which extension is slowing down Word and then figure out what to do about 
the problem. Usually, a minimal insta llation (see Chapter 2) takes care of this problem so 
that you don't have this headache. 

A llocate more RA M for Word 

If enough RAM is available, but you plan on using a lot of graphics in Wo rd documents, 
give Word at least six megabytes of RAM. If enough RAM is avai lable, and you don't 
anticipate using many graphics in Word documents, give Word only four megabytes of 
RAM. 
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To allocate more RAM, make sure that Word is closed, select it with a single click, and pick 
the Get In fo command from the Finder's FiJe menu. In the Microsoft Word Info dialog 
box, select the Preferred size option and reset it for a bigger allocation. Allocating more 
RAM is worth doing any time you will be having a long session in Word because it greatly 
reduces the time it takes to run Word. 

Turn on your Power Mac's v irtual memory 

Power Macintosh users should turn on virtual memory in the Memory control panel to get 
more speed for running Word. Turning on virtual memory ensures that when you launch 
the PowerPC version of Word, only a portion of Word copies into RAM, which saves a lot 
of application loading time. Without virtual memory on, the entire Word application (a 
bit over 4MB) must copy into RAM. 

To make matters even worse, the Microsoft Office "shared libraries"-which take up 
another megabyte or so of RAM-must load, as well . If you then launch another Microsoft 
program (such as Excel), the shared Microsoft Office libraries in the System folder must 
load again for the other program. 

Double-click the Memory option in the Control Panels folder to bring up the Memory 
control panel. When you turn on the Virtual Memory option, you automatically get a text 
box where you can choose how much disk space to allocate as a substitute for RAM. Leave 
it set at 32MB as a good ch oice. 

Set up a RAM disk 

Another trick from the Memory control panel for getting Word to run faster is to set up 
a RAM disk. In a RAM disk, you allocate an area of RAM and load a program into it. Then 
the program loads into this RAM memory at startup and never bothers with disk access, 
at least for the application itself, while it runs. It's worth trying this experiment on your 
system . 

Check your RAM to see if you have enough for a Word RAM disk by choosing About This 
Macintosh from the Apple menu in the Finder. Figure Vl.l shows a system that has 16MB 
of RAM, so there's plenty of room to give Word a 6MB partition. 
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Figure VJ.1 Discovering how much RAM you have to spare. 
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In the Memory control panel, click on the RAM Disk option and set the slider to 6MB or 
a bit more-it's hard to stop on 6M B exactly. The RAM Disk Size box should read about 
6016K. Restart your Mac to make these changes take place. Now when your Mac starts up, 
you should see a RAM disk icon on the desktop. You can treat it just like a high-speed disk 
drive. 

Click the RAM disk icon and drag Word 6 into this drive. Now when you restart, Word 
automatically loads into this area of RAM. There won't be any swapping of Word parts 
from disk into RAM while Word is running; therefore, Word should run much faster for 
you. 

This approach obviously doesn't do much for you if you're trying to run Office on a 4MB 
Centris (actually, you can pretty much forget about Office altogether on really modest 
hardware), but if you have a shiny new Power Mac with 16MB of RAM, this approach is 
your best bet. 

Change bitmap memory allocation 

If you don't import bitmapped graphics, such as TIFF images (EPS and PICT images are not 
considered bitmaps), into Word documents, you may speed up Word by setting its bitmap 
memory allocation to 512K. To change this allocation, you need to make the change in 
the Advanced Settings dialog box. To make this dialog box available on a menu, choose 
Customize from the Tools menu and click the Menu card. From the Categories list, select 
Tools, and from the Commands list, select ToolsAdvancedSettings. Click the Add button 
and then click the Close button. The Advanced Settings command now appears on the 
Tools menu. 

In the Advanced Settings dialog box, select Microsoft Word from the Categories list. In the 
Option box at the bottom of the dialog box, delete any text that may be in the box and in 
its place type BitMapMemory. In the Setting box, type 512 (see Figure VI.2). Click the Set 
button and then click the OK button. 

Aduanced Set tln_gs 
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Figure Vl.2 Changing the bitmap memory allocation. 
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Use Word for a while to see if the change makes Word run faster. If changing this setting 
makes Word run slower, then put the setting back to the way it was before. If you must 
put the bitmap memory allocation back the way it was, open the Advanced Settings dialog 
box, select Microsoft Word from the Categories menu, select BitMapMemory=512 from 
the Options list, click the Delete button, and then click the OK button. 

Change cache size allocation 

If you frequently use Word with documen ts over 64K in size (25 pages or so without 
graphics), you may experience a speed boost by upping Word's cache size allocation from 
its default 64K to a more generous 128K. To change the cache size setting, open the 
Advanced Settings dialog box (see "Change bitmap memory allocation"). In the Advanced 
Settings dialog box, select Microsoft Word from the Categories list. In the Option box at 
the bottom of the dialog box, delete any text that may be in the box and in its place type 
Cache Size. In the Setting box, type 128 (see Figure VJ.3). Click the Set button and then 
click the OK button. (If your Macintosh has more than 4MB of RAM, you can experiment 
with setting the cache size to more than 128K.) Click the Set button and then the OK 
button. 

Rduanced Settings 

Moclll\l sttllf>IO lrlortd In ... ord Sttl lOgr (6)" 

CttOQOrlos: I HlorOJOII Word fEJ ( OK l 
QptfoM: ( Cancel l 
DOC-PATH•Moc:l niO>h HD:Micr""'ft Office: !il 
PICTURE- PATH• Moclnl<rlh HO:Microooft Offlco:Micro,.ft ~ ( Help l 
USER-DOT -PATH•Mocfnt03h HO:M!crosott Offtco:Microsofl 
WORKGROUP- DOT -PATH•Hoc1 ntosh HO:Microsof\ Orflce:M 
INt- PATH• Hot!nt<rJh HD:Sustom follltr:Prefererus: 
AUTOSAYr-PATH• Moclntosh HO: 
TOOLS-PATH• Meotnlo>h HD:Microsott: 
BltMepMomoru•SI2 

0 
Op_t1on: CothoS(ze eo stltlftll 126 1 

Figure Vl.3 Changing the cache size allocation. 

Use Word for a while to see if the change makes Word run faster. If changing this setting 
makes Word run slower, then put the setting back to 64K. The poin t here is that your 
other software, the amount of memory you use, and the kinds and sizes of files you use all 
affect Word's performan ce. The only way to optimize is by performing these experiments 
to see what happens to Word's speed. Really, you don't have much to lose-you may have 
to take two minutes to reset some defaults, but these two minutes can save you two 
minutes every time you open a file! 
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Increase your disk cache 

Poke around in your Memory control panel and try a few Disk Cache settings. Increase 
the disk cache a bit and see if the change makes any difference. It may not, but some users 
have repo rted finding "magic" settings for their systems simply by experimenting with 
this setting. 

Change your monitor settings 

Let's say that you ' re trying to knock out a document that wi ll be printed on a standard 
black-and-white printer. Looking at your mo nito r, you may be just as happy seeing black 
text on a white background, with little monoch rome icons, as you would be seeing the 
same thing with color icons. In the Monitors contro l pane l, every additional simplifica­
tio n counts. The Black & White optio n is faster than the 16 colo rs option, which is faster 
than the 256 colors option, which is much faster than the o the r color options. The speed 
is directly re lated to the amount of information sloshed out of video RAM at each screen 
re fresh; therefore, the Black & White option is notably faster than the color options. 

Rebuild the desktop 

As the weeks roll by, you may notice that it takes your Mac lo nger to start and longer to 
load Word. When this happens, it's tim e to rebu ild your desktop, which is a good activi ty 
not only for speed but a lso for c rash proofing. 

To rebuild your desktop, shut down your Mac and then resta rt \•Vh ile ho lding down the 
Optio n and :l:f: keys. You w ill get a warning box asking whether you really want to rebu ild 
the desktop. Click the OK b utton. If you have a big ha rd drive, the rebuilding process may 
take a minute or two. 

Excel 5 Speed Tips 

Purchase a disk-utility package 

If you discover that Excel is too slow for you, especia lly a t starting up, loading files, and 
saving files, you should get a th ird-party disk-opt imizing utili ty. Excel 5 is a big program, 
and its files a re also larger than the older Excel 4 fi les, so you need a ll the d isk speed you 
can ge t. The Speed Disk utili ty from the Norton Utilities package (see Figure VI.4) looks for 
disk fragmenta tion (fi les and parts of files stored a ll over the place on the disk instead of 
physically together) and moves files around to a storage configuration that allows for 
faster access. 

Excel 5 seems to be particularly sensitive to this fragmentation problem. Even when Speed 
Disk promises only a slight improvemen t in speed, actua l loading tim es for files speed up 
by nearly a factor o f two. If you don't want to b uy a who le disk-utili ty package, but you 
have an online account (with America Online, Prodigy, o r Com p uServe), you can find 
shareware disk optimization programs that can give you the same kind of speed increase. 
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Figure Vl.4 Excel 5 needs the best hard drive performance you can get. 

In vest in a faster M ac 

Every few years App le increases the speed of SCSI bus data transfers (besides upgrading the 
central processor), so you get better hard drive performance with one of the newer, faster 
Macs. The disadvantage o f a newer Mac is that, as of 1995, a faster Mac means a Power 
Mac. In principle this should be nothing but good news. It's not. Microsoft's in-house 
compiler techn ology does not seem to be getting as much speed improvemen t in Power 
Mac applications versus 680x0 as any other vendor. But the Power Mac is a great platform, 
and nearly every other vendor has learned to take advantage of it. Hopefully, sooner­
rather than later-Microsoft will, too. 

Get an accelerator 

In the meantime, if you have a middle-of-the-road 68030 system from a few years ago, you 
actually get more cost-effective acceleration from a 68040 plug-in accelerator card than 
from upgrading to a whole new system. Unfortunately, the Power Mac version of Excel 5, 
at least in its first version, has worse problems with mystery bugs than the 680x0 version, 
so accelerating may be less frustrating than switching to fu ll Power. 
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Turn off Balloon Help 

Make sure that you have Balloon Help turned off. Balloon Help h as pretty much been 
guaranteed to contain no useful information whatsoever, at least for users with more 
than one day's Mac practice. When you shut down this unnecessary function, Excel can 
concentrate on direct interaction with the workspace itself. 

Remove unnecessary too/bars 

You have the option of putting lots of toolbars onscreen (see Figure VLS). If you're not 
actually using one right now, however, close it. Do not leave extra toolbars floating 
around because this practice seriously slows down screen updates. 

WI File Edit Ulew Insert Formnt Tools Dotn Window 1 O:OOPM ~ ClJ 5 

I Ol~C!tlliil~ll~IIL1·11QJlJI~~I:!IL:]IIDI!]I!$IIIJ.I1DO~ 1(9 ~ 

!Geneva 1[3 IT§:J!alLB] I J,uJI!!I• Jflllmfl lllfJ%) 'J ~li~SIIEEJIE:I~ 
II -10n 10) Click anv tool bar vhllc holding dovn CONTIIOL lo dlsplo~ a shortcut menu for 
II ¥ ohovlng, hiding and customizing loolbor~ . 

AI L""J I 
'!sheet 

lit~l 

Reedy ll r:ll 'JNUI11 -.JOJ" 

Figure VI.S Clean up your worksheet display. 

Limit the number of worksheets in your workbooks 

In the Options dialog box from the Tools menu (see Figure VL6), you can find the default 
number of worksheets per workbook. The default has been set by Microsoft to 16, prob­
ably on the assumption that people are using Excel to make up monthly budgets for a 
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whole year and are producing summary sheets, as well. The reali ty is that you can easily 
add new sheets to a smaller workbook with the Move or Copy Sheet command from the 
Edit menu. If you set the v.rorkbook default to 3 or 4 sheets, Excel opens much faster. 
There's no reason to lug around a bunch of blank worksheets in every workbook. 

Options 
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Figure Vl.6 Reset the default number of worksheets per workbook. 

Don't link your worksheets 

I 
I 
I 

I 
I 

Links are great, but they are relatively expensive in terms of performance. If you design 
individual worksheets that contain the same information as four or five linked worksheets, 
you get faster recalculation. Links between workbooks are even more of a performance 
drag than intra-workbook links. Links are a great software feature for the systems of the 
future, but their performance suffers on the modest systems of today. 

Turn on virtual m emory 

Microsoft customer support says that turning on virtual memory in the Memory control 
panel is Tip #1 to in crease the performance speed of Excel. With virtual memory on, only 
3MB of code n eeds to be loaded at startup rather than the whole program. However, this 
advice needs to be explained a bit. 

If you have a Power Mac with less than 24MB of RAM, you have to use virtual memory 
just to get Excel to run at all. If you have 24MB or more of RAM (which you should have 
because other important RISC applications also need lots of memory), however, and you 
turn off virtual memory, you pay a penalty in startup time, but the application runs faster 
after it's opened. 
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On 680x0 systems, Excel itself is smaller. You will have much better results if you just 
accept the Will of Mr. Gates and buy more memory (at least 12MB). Virtual memory just 
loads slower in 680x0 systems, so using it extensively is just about the opposite of a speed 
tip. On the other hand, virtual memory at least makes Excel 5 a possibility for PowerBook 
owners- you probably don't have a 16MB of RAM PowerBook, but you can run Excel 5 at 
a leisurely pace if virtual memory is active. 
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Appendix 

Installing 

Microsoft Office 
The current shipping version of Microsoft Office 4.2 arrives on 29 disks-30, actually, if you 
include the PowerPoint Viewer. Although this is the biggest Macintosh software product, it's 
just a country cousin of Office for Windows, which, in its Professional Edition, includes the 
FoxPro database, as well. Microsoft Mail, as noted in Chapter 29, is a separate option-you 
buy a Mail server license and then get client software either with the license or as a separate 
purchase. In this chapter, you will lea rn about the insta llation options for the fo llowing: 




























































































